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Introduction

Welcome to NeuroCheck 5.1, the leading machine vision and quality control system for
Microsoft Windows. With NeuroCheck, you have chosen a professional software product
designed from years of practical experience and used in thousands of industrial applications.
This guide helps you to get started with NeuroCheck. It introduces you to the software and
its installation, explains the first steps for creating a machine vision application with
NeuroCheck, and shows you how to get comprehensive information about the system.
This Getting Started Guide is organized as follows:
•

Chapter 1 provides an overview of the general concept of the system and the main
areas of application.

•

Chapter 2 contains information on how to get assistance for your work with
NeuroCheck.

•

Chapter 3 guides you through the installation process of NeuroCheck and shows you
the first configuration steps.

•

Chapter 4 gives you a quick guide on how to construct visual inspection applications
with NeuroCheck.
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CHAPTER 1

NeuroCheck Overview

This chapter gives an overview of the application areas and the basics of NeuroCheck.

What is NeuroCheck?
NeuroCheck is a universal image processing system designed for use within automatic
production processes and quality management systems. It offers an integrated environment
for the interactive configuration of visual inspection applications and their automatic execution on the manufacturing line. The following figure shows the basic setup of a visual
inspection system with the required hardware components and communication
connections.

With its broad selection of image processing functions, NeuroCheck can be used in a wide
range of application areas. Highly automated check routine configuration and an intuitive
graphical user interface help to solve visual inspection problems.
NeuroCheck’s communication abilities include remote-control by digital I/O, field bus and
serial interface as well as generating complete inspection records by writing results to file
or transmitting them via serial interface. NeuroCheck also supports OLE Automation,
which is fast establishing itself as a new standard in process automation. This makes
NeuroCheck ideally suited for today’s highly integrated production processes and modern
quality management systems.
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Application Areas
This section gives a brief introduction to typical visual inspection tasks NeuroCheck can
be used for. You will find examples for all these application areas on the NeuroCheck Web
site http://www.neurocheck.com and in the reference book Industrial Image Processing
published by Springer Verlag (Berlin Heidelberg New York), which presents solutions
from all areas of industrial visual inspection created with NeuroCheck.

Code Identification
Examples for bar code identifications abound in all
industrial areas, as different types of bar codes are used
for the identification of all kinds of products in packaging, logistics, manufacturing control... NeuroCheck
reads all common bar codes with contrast levels as low
as 5%, forward and backward as well as in horizontal or
vertical direction and even rotated.
The two-dimensional DataMatrix code offers higher storage capacity
than conventional bar codes and increased robustness through the
advanced ECC-200 method for error correction. NeuroCheck’s
highly configurable DataMatrix identification function detects and
decodes DataMatrix codes at any angle of rotation, in negative or
positive print and under difficult surface conditions.

Presence and Assembly Verification
Use NeuroCheck to detect the presence
of all required parts and components
easily and reliably. Examples for this
type of application are:
•

Check presence of connector pins.

•

Check number of tablets in a blister
or the completeness of packaging
contents in general.

•

Check circuit board components.

•

Check correct injection mold of
plastic parts.

•

Inspect work pieces for damage
(using appropriate measurements).

•

Check presence of screws, contacts, markings, inscriptions etc.

•

Check fill level and correct closure of bottles.

NeuroCheck Overview
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Optical Character and Pattern Recognition
NeuroCheck uses adaptive classifiers for character recognition. They can be trained to recognize characters in arbitrary fonts, created by every marking technology used in the
industry, for example laser-engraving, stamping, printing ...
Combined with NeuroCheck’s versatile image processing functionality, this technology
can be used for a wide variety of reognition tasks, including for example company logos or
special codes.

Image Comparison
The most typical application of image
comparison methods is print quality
inspection. In contrast to optical character recognition, the objective here is
checking the quality of the print by
evaluating the correspondence of the
print to a reference image.

Gauging
You can use NeuroCheck to check every aspect of
the geometry of a work piece, e.g. distances
between objects, angles between edges, parallelism, concentricity... Special subpixel algorithms
allow for measuring with an accuracy of up to 1/
10th of an image pixel.

Robot Guidance
The term ”Robot guidance” summarizes all applications in which an image processing
system is used to determine the position and orientation of an object and outputs this position in order to enable another machine to handle the object. A robot gripper can thus be
enabled to grab work pieces from a conveyor belt. Another application is palletizing or
depalletizing of crates containing assembly parts, packages or bottles.
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Color Processing
Processing of color images in NeuroCheck is based on an intelligent matching process
which can be customized for the specific requirements of each application. This allows
color images to be analyzed with field-proven gray level algorithms and the speed and
ease-of-use customary in NeuroCheck. This is especially interesting, if
•

Objects have to be distinguished based on their color, e.g. electronic components or
LEDs.

•

Segmentation of the objects is not possible in the gray scale range because they do not
exhibit a brightness contrast.

An example for the second case is shown below. The presence of sealing agent is to be
tested. It does hardly differ in brightness from the surface of the test piece, as shown in the
left image. A color image (center, as can be seen in the PDF version of this Getting Started
Guide) allows for a clear distinction which can be exploited by the NeuroCheck conversion algorithm whose result is shown on the right.

Surface Inspection
Surface inspection applications frequently use line-scan cameras to scan the surface of
large or cylindrical parts in order to check for scratches, holes, rough areas etc. Using linescan cameras in NeuroCheck is just as simple as using area-scan cameras. The same image
processing functionality is available, shown here for gauging and defect detection on the
surface of a cylindrical part.

NeuroCheck Overview
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Basic Check Routine Structure
This sections explains some basics of the structure of visual inspections in NeuroCheck.

Check Routine
The check routine is the fundamental element in
NeuroCheck. It comprises the complete visual inspection of one work piece. A check routine typically consists of several individual checks inspecting different
aspects of the work piece. The final result of a check
routine, i.e. the statement, whether the work piece is
good or faulty, is derived from the results of the individual checks.
The image shows the entire hierarchy tree of a check
routine with several individual checks and their check
functions. The individual elements of the tree are
explained in more detail in the following sections.

Individual Check
Individual checks (or simply: checks) inspect different aspects of a work piece. A check
might measure a bore hole, verify the presence of a component or read a line of characters.
After all checks for a work piece have been carried out, their results are combined to form
the final result of the check routine.
Checks are independent of each other, they do not exchange data. Usually checks are executed in the order in which they appear in the check routine. However, it is also possible to
execute a check depending on the result of some other check, i.e., the ”O.K.” or ”not
O.K.” result of a check can be used to decide which check to perform next. This is configured on the Flow page of the check routine tree view shown above. The sequence of
checks in the tree view can be altered by simply dragging checks to a new position with
the left mouse button pressed.

Check Function
Check functions are image processing, communication or system functions that can be
inserted into a check to carry out specific tasks. NeuroCheck provides check functions for
various tasks, such as filtering entire images, searching and measuring individual objects,
reading from or writing to digital I/O connectors etc.
The check functions of a check are executed in sequence. They exchange data through thedata pool of the check. Usually a check function gets its input data from the preceding
function, but this assignment can be changed on the Input page of the check routine tree
view shown above. The parameters of every check function can be set individually in a
parameter dialog, giving extensive visual assistance to the user.
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Modes of Operation
This section explains the different modes of operation in NeuroCheck.

Manual Mode
In manual mode you construct check routines, set check function parameters and test the
inspection. Chapter „Creating a New Check Routine” gives an introduction to the process
of building a check routine in manual mode.
Manual mode is entered by clicking the icon depicted on the left or by choosing Manual
from the Operating Modes menu. The manual mode edit pane on the left shows the check
routine tree view with its five edit pages:
•

Structure: for appending, inserting and configuring individual checks and check
functions.

•

Input: for viewing and configuring the exchange of data between check functions.

•

Output: for viewing and configuring result data output to peripherals.

•

Flow: for viewing and configuring conditional execution of individual checks.

•

Documentation: for describing the check routine, individual checks and check
functions.

Below the tree view, an overview of various vital check routine properties and statistics
can be activated by choosing Check Routine Overview from the View menu.
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On the right, manual mode shows the result of the last check function executed or various
other types of status information. The right window pane, the so-called result view, can be
split to show different types of results simultaneously.

Live Image Mode
„Live image mode“ is entered by choosing Live from the Operating Modes menu. In this
mode the complete NeuroCheck window is used to display the live camera image with
adjustable zoom levels for easy focusing.

Automatic Operation and Screen Configuration
In automatic mode, NeuroCheck is typically controlled from the outside, for example by a
PLC via digital I/Os or serial interface or by another program through OLE automation.
Automatic operation is started by clicking the icon on the left or by choosing Automatic
from the Operating Modes menu. Options for automatic mode include:
•

Start of check by keystroke, timer or external signal.

•

Check routine switching upon external signal.

•

Display of adjustment dialog for adjusting camera positions upon external signal.

•

Report of result data to PLC or master computer.

General configuration options for external control and communication are set by choosing
Remote Control from the System menu. Other options, like output of result values, are
specific to each check routine.
The appearance of the NeuroCheck screen in automatic mode is highly configurable.
Below, we show an example of an application specific screen layout. Screen configuration
is performed in Automatic Screen Configuration mode, entered by choosing Configure
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Automatic Screen from the Operating Modes menu or by clicking the icon on the left.
Since the screen configuration depends on the functions available in the check routine and
their respective result displays, it is again specific for each check routine.
The image shows an example for an automatic screen with four inspection windows, a
windows displaying result statistics, a monitor window for digital input/output connections and a system protocol.

User Interface
The user interface has been designed with two goals in mind: making the use of digital
image processing as simple as possible while giving the experienced user full access to all
features. These goals have been achieved by a highly automated configuration system
combined with intuitive control elements for the comprehensive set of options available.

User Guidance
Context sensitivity is a very important element of user assistance. NeuroCheck permanently checks what actions are possible at any given moment when editing check routine
structure or setting parameters. It will make available only operations that are actually possible at this point. For example, it is not possible to insert a check function into the check
routine unless all the data required by the function is available. This prevents errors caused
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by an interrupted flow of data through the program. NeuroCheck will also display a hint in
the Select New Check Function dialog box explaining why a function cannot be used at
that point and what is required prior to using it.

Automatic Configuration
Check functions are automatically connected according to the results already available;
this guarantees consistent data structures. Many times preset parameters giving good
results for a wide range of applications eliminate the need for manual configuration.

„Short Ways“
The NeuroCheck user interface adheres closely to the Windows standard with its emphasis
on context sensitivity and visual guidance, e.g. through the use of graphical sliders for
parameter adjustment.
Right mouse button. The right mouse button is used extensively throughout the
NeuroCheck user interface for setting properties of the currently active object. For example:
•

Check routine descriptions: right-click the
check routine name in the tree view.

•

Individual check settings: right-click the
name of the check in the tree view.

•

Adding, deleting and configuring check
functions: click functions in the tree view.

•

Settings for individual regions of interest or
groups in graphical parameter dialogs: right-click the selected region/group in the
graphical display of the dialog
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In accordance with the Windows user interface guidelines, the right mouse button never
initiates an action directly, it always opens a context menu. This makes it safe and easy to
experiment with the right mouse button.
Alternative controls. In
many cases, several ways
achieve the desired effect. For
example, in the Device Manager dialog box, properties for
the devices can be set by choosing the Properties button or
from the context menu of the
device. Most check function
dialogs also offer control elements for direct access to the
most important parameters,
whereas the right mouse button
leads to additional options for
individual objects.

“In-place editing”. Names of checks and check functions in the check routine tree view, camera inputs and
digital communication channels in the Device Manager
can be edited just like file names in the Windows
Explorer. Click the item once with the left mouse button
to select it, then a second time to start editing.

CHAPTER 2

Getting Help

This chapter will show you how to get assistance while you work with NeuroCheck. It
explains how to make use of built-in help features of the program, how to access resources
on the World Wide Web, and whom to contact for technical support.

Printed Documentation
Premium and Professional editions of NeuroCheck are accompanied by comprehensive
printed documentation, including
•

This Getting Started guide.

•

The User-Manual with detailed references to all modes of operation, communication
interfaces, check functions etc. in NeuroCheck.

•

The Training Course which will lead you step by step through the process of
configuring visual inspection applications, from bar code reading to gauging, from
presence verification to optical character recognition.

•

The Operator Manual is primarily written for operators and set-up people working
with NeuroCheck visual inspection stations.

•

The Programmer’s Reference detailing the various programming interfaces enabling
you to customize NeuroCheck and extend its functionality.

Additional technical information about visual inspection systems, image processing algorithms, image capturing and illumination, can be found in our reference book Industrial
Image Processing, published by Springer Berlin Heidelberg New York (ISBN 3-54066410-6).

Online Help
The online help system provides the information you need where and when you need it:
directly on the machine while you are working with NeuroCheck. There are several ways
of accessing online help information relating to different types of information and different work situations.
NOTICE
For the benefit of the environment, we will no longer print and mail manuals.
Please find the manuals as PDF documents on your installation medium or in the service area
under downloads on our website.
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Reference Information
The online help system offers an extensive amount of reference information about
NeuroCheck’s modes of operation, communication facilities and check functions. Reference information is typically accessed through the Help menu.

The Help Topics command displays the Contents/Index tab with the hierarchical table of
contents of the help system.Its chapters provide information on all areas important for
working with NeuroCheck.

The most extensive section of the help system is the check function reference explaining
the operation and parameters of every check function used to build visual inspection routines in NeuroCheck. Since this information is frequently needed when configuring check
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routines, it can be reached directly from the context menu of the check functions in the
check routine tree view.

Context Help
The NeuroCheck help system also provides context-sensitive help for the elements of the
user interface. For example, pressing the F1 key on a highlighted menu command displays
help for that particular command with hyperlinks to further information. Context-sensitive
help is also accessible for toolbar commands by first clicking the help button shown on the
left, then the toolbar button in question.

Help for check function parameters
Probably the most important type of context help is help for check function parameters.
This help information is accessed using the help button in the title bar of the parameter
dialog boxes. Clicking this button first, any control element inside the dialog box next,
opens a popup window explaining the corresponding parameter setting. Without interrupting your work flow you can immediately check the meaning of the parameter and its effect
on your inspection routine.
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Status Messages
Another very important means of providing help related to the current context of your
work are the status messages given by check functions during development of a check routine in manual mode. All status messages issued by check functions in NeuroCheck are
displayed in the familiar HTML format and use its navigational features to make your
work with NeuroCheck even simpler. The error message of function Capture Image
shown below informs the user about possible causes of the error and offers direct links to
the Simulate Image Capture command and the Device Manager to correct the problem
immediately.

Other Help Resources
A standard installation of NeuroCheck includes our list of frequently asked questions
(FAQ) with a host of tips and tricks collected from daily work with NeuroCheck, covering
different system setups, hardware combinations, inspection tasks etc. Choosing FAQ from
the Help menu opens this collection in your favorite web browser.
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The hierarchical structure of the FAQ, sorted by typical actions performed in NeuroCheck
and by functionalities facilitates finding the required information quickly and easily.

Web Resources
The FAQ list also provides direct links to our web site http://www.neurocheck.com where
you will always find the latest version of this list together with manifold information on
industrial image processing with NeuroCheck.

Product Support
If neither documentation nor web resources provide a solution for your particular problem,
contact your local NeuroCheck support office. The preferred method of contact is via
email as this enables content-rich information about problems and solutions, frequently
including test images and check routines.

Germany
NeuroCheck GmbH
NeuroCheck TechSupport
)ULHGULFKVWU
70174 Stuttgart
Phone: +49 (0) 711 22 96 46 31
Fax: +49 (0) 711 22 96 46 59
Email: support@neurocheck.com
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United Kingdom and Ireland
Industrial Vision Systems Ltd.
Kingston Business Park
Kingston Bagpuize
Oxfordshire
OX13, 5FE
England, UK
Phone: +44 (0) 1865 823322
Fax: +44 (0) 1865 823393
Email: support@industrialvision.co.uk

Other Countries
Please refer to our web site http://www.neurocheck.com for information about local support offices in other countries.

CHAPTER 3

Installing NeuroCheck

This chapter guides you through the installation process of NeuroCheck and shows you
the first configuration steps.

System Requirements
Installing and using NeuroCheck requires a PC running Microsoft Windows.
NeuroCheck’s system requirements are the following:
•

Operating system: 32-bit Windows 7 / Windows Vista / Windows XP /
Windows 2000 (ServicePack 4 or higher),

•

IBM® Personal Computer or fully compatible,

•

SVGA Monitor and graphics adapter (preferred resolution 1024*768, true color),

•

Pentium processor or better (preferably Pentium III or later),

•

128 Mbytes of main memory (512 Mbytes recommended),

•

Free hard disk space (depending on the amount of installed sample files): At least 80
Mbytes, approx. 140 Mbytes for a complete installation),

•

CD-ROM drive.

This configuration is sufficient for using NeuroCheck as a development system in an
image processing laboratory. Applying NeuroCheck as a completely automatic inspection
system requires the following additional components:
•

FireWire camera or frame grabber board with camera.

•

Digital I/O board, field bus board or serial interface for communication with PLC or
master control computer.

Information on how to configure NeuroCheck for using these hardware components is
given later in this chapter.

Before Installation
First, please connect the security key (dongle) to the USB or parallel port of your PC. The
installation program does not need the key, but if you want to test NeuroCheck immediately, it will start with unrestricted functionality only when the security key is present.
If the parallel interface of your PC is used by any other device, e.g. a printer, simply insert
the security key into the parallel interface, then connect the device to the security key. The
security key does not affect these signals.
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Installation Procedure
To install NeuroCheck from a CD-ROM click ‘NeuroCheck English' in the CD interface
program which is automatically started after inserting the CD-ROM into the CD-ROM
drive of your PC (if CD autostart is deactivated on your system, please start the
NCHECKCD program from the root directory of the CD). The installation program will
automatically detect your operating system and install the correct files.
The welcome screen of Setup prompts you to close other Windows applications first. This
is recommended because some shared resources have to be installed into the Windows
system directory along with NeuroCheck. If no other programs are running, you can continue by choosing Next or pressing the RETURN key.

Determining User Information
The setup reads user information from your system’s registry. If the Windows system has
not been installed using your name, you may have to change the information in this dialog
box.

Choosing the Installation Directory
In the next step, the setup asks you whether you want to install NeuroCheck into the standard directory \Program Files\NCheckXX on the Windows system drive, where XX
stands for the NeuroCheck version. You can select a different directory by choosing
Browse, but we recommend that you simply confirm the default selection which is based
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on the Windows setup guidelines. To confirm the default selection, simply choose Next or
press RETURN.

Selecting the Setup Type
In the following dialog box you can choose from several types of setups by selecting the
appropriate button. The Standard setup installs NeuroCheck with the typical components.
The Complete setup installs all components. The Custom option lets you decide, which
files to install.
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Selecting Additional Components
If you selected the Custom setup option, the following dialog box will appear in which
you can select the components to be installed.
Features shown in white will be installed completely, including all subfeatures they may
have.
Features shown in gray will be partially installed, i.e., some of their subfeatures are
selected for installation, others not.
Features marked with an X will not be installed at all; this entails that none of their subfeatures will be installed, either.
The / icons let you open and close the individual feature branches. Clicking the icon
of a feature opens a context menu where you can select whether the feature – possibly
including its subfeatures – is to be installed on a local drive of your machine or somewhere
in the network. The last menu command lets you prevent installation of the feature
entirely. Thus you can select individually which components are to be available. The Disk
Cost button allows you to check to space requirements of your current selection at any
time.

Selecting individual features is especially interesting for the installation of hardware drivers as shown in the image. You can configure the installation in such a way that it will
install only drivers for the hardware that you are actually using. Of course you can use the
maintenance capabilities of the Windows Installer at any time to add or remove features at
a later date. You only need to open the Add/Remove Programs utility from the Windows
control panel and select „NeuroCheck 5.1 (English)“.
When you have made your selection, click the Next button or press the enter key.
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Copying Files
When all settings have been made, Windows Installer will ask you one final time whether
you want to continue the installation or change your settings. If you confirm with the Next
button, the Windows Installer will copy the NeuroCheck files to the destination path. A
progress dialog informs you about the steps currently being taken.

Completing the Installation
The Windows Installer then informs you about completion of the installation in a final dialog box. After confirming this dialog box with the Finish button, you can start
NeuroCheck like any other Windows program from the Start menu. The Start menu also
contains entries for the current readme, the online help and other installed documentation.
Νote. If the setup program was unable to update specific files because they were in
use during installation, it will ask for a reboot here. You should restart your system
before starting NeuroCheck to guarantee that all files are current.

Additional Tools
Microsoft Internet Explorer
Some of the new features of NeuroCheck 5.1 use Microsoft Internet Explorer as a functional component, e.g. the new HTML status messages and check routine descriptions.
You can use this functionality only if the Internet Explorer is installed. Version 5.0 or
higher is recommended. An English version of Internet Explorer is located in the
Extra\InternetExplorer\English directory on the CD.
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Note. If using Internet Explorer is undesirable in certain production environments,
the entire image processing functionality of NeuroCheck can be used without it.
You will then have to start NeuroCheck with the /NOIE command line option.

Adobe Acrobat Reader
Parts of the additional documentation require Adobe Acrobat Reader 4.0 or later. A current installation is located in the Extra\Acrobat\English directory.

After Installation
Start Menu
Now you can run NeuroCheck and the documentation files belonging to NeuroCheck from
the NeuroCheck submenu in ‘Start\Programs’.

The installation program also creates a desktop shortcut which you can use to start
NeuroCheck directly.
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A First Test
Start NeuroCheck from the Start menu. From the NeuroCheck intro screen you can load
the demonstration check routine, browse through a tutorial or view the information dialog
box:

If this dialog box does not indicate the license level you acquired (Runtime, Professional
or Premium), the security key is probably not attached or the dongle drivers have not been
installed. You can easily verify the presence of the dongle in the NeuroCheck status bar. If
the dongle was detected successfully, the status bar will show a small icon shaped like the
security key.

If this icon is missing, exit NeuroCheck and connect the security key to the USB or parallel port of your PC, as described in section „Before Installation”. After starting
NeuroCheck again, the box should display the appropriate license and serial number.

Executing a Sample Check Routine
From the intro screen, you can directly enter the demonstration check routine. Its start
screen will give you further information about getting a first impression of NeuroChecks
capabilities.
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Hardware Configuration
Installing Special Hardware Components
Please refer to the manuals supplied by the hardware vendor for information on installing
special hardware components, such as frame grabber and digital I/O boards.

Setting up Hardware
Before you can use cameras, frame grabber boards, digital I/O boards, field bus boards or
the serial interface from NeuroCheck, you have to configure NeuroCheck accordingly.
This section demonstrates the setup process for a FireWire camera.
Start NeuroCheck, switch to manual mode using the depicted icon and choose Device
Manager from the System menu. In the (currently completely empty) device manager
click New.
On the first page of the hardware wizard, which will help you setting up your hardware,
select IEEE1394(FireWire) camera and click Next.

The second page will differ depending on the type of device selected on the first page, but
the basic functionality is always identical. Select from the topmost list box the make and
model of the hardware you want to install. Additional control elements are used to set up
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parameters of the hardware. Only in rare cases will it be necessary to change the default
settings.

The final page of the hardware wizard summarizes the setup information. Choosing
Finish sets up the selected hardware device after checking for its presence.

Using the Info button, you can easily check the installation of the required low-level drivers for the selected board.
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Removing NeuroCheck
NeuroCheck supports the standard uninstall and maintenance procedures of Windows.
Like any other Windows application, you can remove NeuroCheck from the control panel.
Please refer to the Windows documentation for further information. Uninstall may inform
you that it was unable to remove some components. This is due to the fact that
NeuroCheck installs shared resources that may be used by other programs and might
therefore not be safely removed. It is also possible that they are within the NeuroCheck
directory which the installation program did not create and which the uninstall program
therefore does not know how to deal with. In this case, again, the NeuroCheck installation
directory will remain in existence after deinstallation.

CHAPTER 4

Creating a New Check Routine

This chapter gives you an introduction into configuring visual inspection programs with
NeuroCheck. In a standard installation of NeuroCheck, you will find the complete check
routine as TUTO_1.CHR in the EXAMPLES directory below the installation directory.

Inspection Task
Below you see an image of a blister with ten pills. The inspection task is to determine
whether exactly ten pills are present.

The complete solution of a visual inspection task is encapsulated in NeuroCheck check
routine. Such a check routine can consist of several individual checks, inspecting different
aspects of a work piece. In this case only one criterion has to be checked, therefore the
check routine will contain only one check.

Creating the Check Routine
In the intro screen NeuroCheck shows when Internet Explorer is installed as well as in the
normal manual mode you can create a new check routine by choosing New from the
Check Routine menu or by clicking the depicted icon.
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NeuroCheck then shows the manual mode screen with an empty check routine. It will
automatically create a standard description for the check routine in HTML format – again
provided that the Internet Explorer is installed.

Check Routine Description
First you should enter a description for the check routine in
order to properly identify it later. Click the first line of the
check routine tree view, reading „Check routine“, once with
the left mouse button to highlight it, then again to switch to edit
mode. A cursor appears, allowing you to enter a new name for
the check routine. Enter „Blister inspection” and confirm with
the RETURN key.
Proceed in the same way with the following lines to enter „Verify presence of pills” as the comment in the second line, your
name as the operator in the third line. The lightning icon in the
fourth line represents the identification number used to switch
check routines in automatic mode and will not be used in this
tutorial. Now the edit tab should look as shown in the figure.
Note that these changes are immediately reflected in the
HTML-page in the right window pane.

Saving the Check Routine
Before you start working on the inspection task, you should save what has been created so
far. From the Check Routine menu choose Save or click the depicted icon. The familiar
Windows file selection dialog appears. Enter a name for the check routine, e.g. Tutorial 1. You do not need to enter a file extension, this is done by NeuroCheck. Confirm
with OK. You will now see the file name appear in the title bar of the NeuroCheck window
and the date and time of the save operation in the right window pane.
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Creating and Editing Checks
As mentioned before, a check routine is made up of individual checks, performed independently of each other. A first check is automatically created together with the new check
routine. Additional checks can by created by choosing New Check from the Edit menu
or from the context menu opened by clicking the background of the tree view with the
right mouse button.
The title of the check itself can be edited in the same way as that of the check routine. The
title of a check has a special significance. Over time you will repeatedly encounter inspection problems very similar to one you already solved. NeuroCheck can import complete
checks from other check routines so that existing solutions can be re-used. Entering a
meaningful title helps identifying such “library checks” for importing.

Image Acquisition
Up to now the whole check routine consists of framework only, it does not do anything
useful. All the work in a check routine is done by so-called check functions. We will now
add the first check function to our check routine in order to provide the check with an
image to be inspected. Usually this image will be captured by a frame grabber from a camera, then transferred to NeuroCheck for processing.
Capturing and transferring are separate processes which allows for greater flexibility in
selecting and configuring image sources. We will skip the capturing here so that you can
work through this example without the need for a camera, frame grabber or test piece.

Transferring the Image
The first check function to be added to the check is therefore function Transfer image.
Choose New Append Check Function from the Edit menu or the context menu opened
by clicking the title of the check with the right mouse button as in the following image.

Alternatively you can click the depicted icon. The effect will always be the same : the dialog box for selecting a new check function is displayed.
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The dialog box contains a separate page for every function category in NeuroCheck. The
pages are switched using the buttons on the left of the dialog box. You will find the functions for image acquisition on the Acquisition page with the camera icon.

Select function Transfer image and confirm with OK. Your check will now look like this:

Setting Parameters
Now you have to tell NeuroCheck what image to use. This means you have to set parameters for function Transfer image. In the standard configuration after installation,
NeuroCheck will automatically display the parameter dialog of the function after appending. If this option has been switched off on the User Interface page of the System Options dialog, you can use one of the following methods:
If the function is selected as in the above image, you can click the depicted icon or choose
Parameters from the Check Function menu.
The second method is to click the name of the function with the right mouse button and
choose Parameters from the context menu.
The third method is a double click on the function name in the edit tab.
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Parameters for Image Transfer
The following dialog box will appear, except that it does not display an image yet:

Select the Bitmap file option, then use the Browse button to select the file TUTO_1.BMP
from the EXAMPLES directory within the NeuroCheck installation directory. Confirm
your selection with OK.
The blue frame indicates the image section actually read. It can be moved by dragging it
while holding the left mouse button down. Dragging one of the marks on the edges
changes the size of the frame. You can also use the Full image button to load the entire
image. Then leave the dialog box with OK.

Executing the Image Transfer
You can run the check routine up to this point by selecting function Transfer image in the
tree view with a mouse click and choosing Execute from the Check Function menu or
clicking the depicted icon. You can also click the function name in the check routine tree
view with the right mouse button and choose Execute from the context menu.
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NeuroCheck then executes the check routine up to this point and displays the result in the
right window pane, i.e. the section loaded from the image. The NeuroCheck window now
should look approximately as in the following image:

Now you should save the check routine again by choosing Save from the Check Routine
menu or the depicted icon. The check routine is saved under the previously assigned file
name. The menu command Check Routine/Save As... allows you to save the check routine under a new file name.

Regions of Interest
The pills are objects within the image. All functions dealing with objects belong to the
function categories marked with the icon shown here and require a region of interest to
work with. Therefore, we have to set a region of interest now. Proceed as before to append
a new check function to your check. This time, select the Objects page in the Select
Check Function dialog.

Unavailable Functions
You will notice that a lot of functions on this page are marked with the red icon shown
here. These functions cannot be appended or inserted into the check at that point. If you
select such a function, the status line of the dialog box will show an explanation as to why
the function cannot be used at the moment. Here the reason is that all these functions
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require at least one region of interest to be defined. Therefore, the only function currently
available from this group is function Define ROIs. Append it to your check routine.

Define Region of Interest
We will simply search the whole image for the pills. This means that the region of interest
will comprise the entire image. Open the parameter dialog of function Define ROIs and
select the Rectangle option. In the graphics panel on the left, draw a rectangle by dragging
the mouse with the left mouse button pressed. Switch to Select mode using the radio buttons on the right, then click the rectangle with the right mouse button and choose Full
image from the context menu. The region of interest will then cover the entire image section read into memory.
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Thresholding
The pills contrast well with the background. Therefore, a simple thresholding operation
will suffice to isolate the objects in the image. First a threshold has to be computed. This is
the task of function Determine threshold. Append this function to the check. You will
find it on the same page as function Define ROIs.
Executing the function removes all gray shades from the image, leaving only black and
white areas.

Display Options
A closer look at the right window pane of the NeuroCheck window will reveal a double
frame on top. If you drag the lower frame downward, holding down the left mouse button,
you will see a histogram of the image in the upper pane, the thresholded black and white
image in the lower pane. But function Determine threshold offers even more display
options. There are several control elements on the top border of each pane, from which
you can select the display option to be presented in the corresponding pane and the zoom
level. Click the Source image tab above the upper pane and select a zoom factor of 50%
for both panes. Now the NeuroCheck window should appear as in the following image,
allowing you to compare the original gray level image to the thresholded binary image.
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In addition to these options each pane has a context menu opened by clicking the right
mouse button within this pane. From this menu you can transfer the image displayed in the
respective pane to the Windows clipboard, from where you can paste it to any Windows
application, e.g. to document your check routine.
Note. The context menu of the left window pane with the check routine tree view
also has a Copy command. There, the effect is to transfer a text listing of the check
routine, i.e. the check function sequence, to the clipboard from where it can be be
pasted to a word processor for documentation purposes.
A final note on the display: the background of the NeuroCheck result window pane can be
configured. Choose Options from the System menu, go to the Color page and select your
preferred color for the gray level image background.

Searching for the Pills
The pills are clearly separated from the background in the thresholded image. We can now
isolate them as objects from the image scene. Append function Create ROIs by Thresholding to your check routine. Again, you will find this function on the Objects page of
the Select Check Function dialog box.
In the parameter dialog of Create ROIs by Thresholding set the options as in the following image in order to find all bright objects. You can either click the graphics panel with
the right mouse button and choose Object Color Light from the context menu or use
the corresponding list box on the right of the dialog box.

Running the check routine up to this point separates all ten pills as individual objects from
the background. Now their number has to be checked to complete the solution of this
inspection task.
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Checking the Number of Pills
Append function Count ROIs to the check routine. You will find this function on the
Analysis page of the Select New Check Function dialog box. Since this function can be
used to verify the compliance of an existing object configuration with prescribed values, it
has a target value dialog instead of a parameter dialog (though there are functions having
both).
Open the target value dialog by double-clicking the function or by clicking the icon on the
left or by choosing Target Values from the Check Function menu or the context menu.
Activate the Verify option (the function can be used simply to count objects, without
deciding, whether the number is correct or not). Enter „10“ for the minimum as well as for
the maximum value, because there have to be exactly ten pills present.

Confirm with OK and execute the check routine. NeuroCheck informs you that the work
piece is OK since it contains the required number of objects. The screen shot below shows

Creating a New Check Routine

45

the default display appearing automatically, if the right window pane was horizontally
divided as described above in section „Thresholding”.

With this final step the inspection task has been solved. Again, you should save the check
routine.

Automatic Execution
Immediately after saving the completed check routine you can have it executed in automatic mode. On the other hand, this means that you can reconfigure an automated visual
inspection anytime, having all the features of the manual mode user interface at your command.

Triggering Check Routine Execution
In a real-world production line inspection system, check routine execution in automatic
mode will typically be started by an external signal, i.e. via digital inputs or serial interface. Here we will trigger the start manually. We have to configure this first since in its
standard configuration after installation, NeuroCheck will not react to start signals.
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Choose Remote-Control frome the System menu and activate the Start check signal on
the Input Signals page by clicking the check box in front of the signal designation.

In the standard configuration, the Source column on the right will show a manual operation using the ENTER key. If not, you can change this using the Change button. These settings affect the system as a whole and can therefore not be made while the system is
running in automatic mode.

Switching to Automatic Mode
Choose Automatic from the Operating Modes menu or click the depicted icon in the
mode bar to switch to automatic mode. In NeuroCheck’s standard configuration, you will
receive a warning message about image transfer from file. You can simply confirm this
message. It is intended to prevent a production check routine from accidentally checking
stored images instead of current camera images of test pieces.

Automatic Mode Screen
After switching to automatic mode, NeuroCheck displays a default screen layout. When
you have made the remote-control configuration as described above, NeuroCheck will
execute the check routine once after you press the ENTER key and display some informa-
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tion in the windows on the automatic mode screen.The following figure shows the default
configuration of the automatic mode screen.

The automatic mode display can be configured by choosing Configure Automatic Screen
from the Operating Modes menu or clicking the corresponding icon on the mode bar. In
this operating mode you can add, resize or delete windows on the automatic screen and set
window properties, like the zoom factor to be used.

End Automatic Mode
Automatic mode is ended by choosing Manual (or any other mode) from the Operating
Modes menu.

From Here
Now you have a first impression of how to work with NeuroCheck to solve visual inspection tasks. To get a deeper understanding of the structure of the program and an overview
of its capabilities, you should work through the Training Course included with the package or book a training at your local NeuroCheck support office.
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